
Mathematics for economic analysis, Homework set 1.

See also the HW1.ods or HW1.xlsx files. Their sheets are: Basic plotting, Newton-Raphson error, Recognizing exponential
growth, Euler method.

1 Plotting of sequences

1.1 Sample exercise of plotting a sequence

Plot the sequence an! Is it seems to be true/false for an: a) monoton increasing/decreasing, b) bounded (maybe only from
above/below), c) convergent/divergent, d) if is divergent, does it converge to ±∞ ?

an = (−1)n
n+ 3

2n+ 5
, n = 0 . . .∞, plot for n = 0 . . . 20.

Solution:

LibreOffice:

A2 : enter 0,

A3 : enter =A2+1,

select A3:A22,

Sheet -> Fill Cells -> Fill Down

B2 : enter = (-1)^A2 * (A2+3)/(2*A2+5),

select B2:B22,

Sheet -> Fill Cells -> Fill Down,

select A2:B22,

Insert -> Chart ... Choose Chart Type: XY (Scatter) .. Lines only ... Finish

Octave (Matlab):

for i = 1:21

n(i) = i;

an(i) = (-1)^(i-1)*((i-1)+3)/(2*(i-1)+5);

endfor;

plot (n,an);

Mathematica (Mathics):

an = Table[ (-1)^(i-1)*((i-1)+3)/(2*(i-1)+5), {i,1,21} ]

ListPlot[ an ]

DiscreteLimit[ (-1)^(i-1)*((i-1)+3)/(2*(i-1)+5), i->Infinity ]

SAGE:

point( [ (n, (-1)^n*(n+3)/(2*n+5)) for n in [0..20] ] )

var( ’n’, domain=ZZ )

limit( (-1)^n*(n+3)/(2*n+5), n = +Infinity )

WolframAlpha:

listplot table (-1)^n*(n+3)/(2*n+5) for n from 0 to 20

limit (-1)^n*(n+3)/(2*n+5) n goes to infinity
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Figure 1: Plot of the sequence an = (−1)n n+3
2n+5 .

Result: The sequence seems to be a) bounded, since its values are in the range [−0.6, 0.6], b) not monoton, since the
curve of the plot goes both up and down, c) not convergent, since it takes infinitely many values around both of ±0.5.

Remarks:

� Links to online software: Octave, SAGE, WolframAlpha. Mathics installer: Mathics.

� Another (relatively small) symbolic algebra package: wxMaxima

� Octave can do symbolic calculations, that requires to load an extra package ”symbolic”.

� In the online SAGE calculator run separately the first (point...) line and the next two (var.., limit..) ones.

� The limit of a sequence (which can be regarded as a function defined on integers) might be different from the limit
of the ”same” function defined on the reals. In Mathematica this is handled by using ”DiscreteLimit”, as opposed to
”Limit”. (Mathics has only ”Limit”.)

In SAGE try

var( ’n’, domain=ZZ )

sin(n*pi)

as opposed to

var( ’n’, domain=RR )

sin(n*pi)

Here ZZ means the integers, while RR denotes the real numbers. The first result is zero, since sin(nπ) = 0 for all
n ∈ Z, while the second one is ”ind” (indefinite), as sin(πx) oscillates between ±1 for x ∈ R.

� It is not always easy to find the correct form of the query to WolframAlpha. Try

listplot of the table (-1)^n*(n+3)/(2*n+5) for n from 0 to 20

with or without ”of the”!

Try also queries like ”Hungarian GDP last ten years”.

1.2 Exercise (plotting)

Repeat at least the spreadsheet part of the previous sample exercise for a few of the following an sequences:

n+ 3

2n+ 5
,

3

2n+ 5
, (−1)n

3

2n+ 5
, n2 + n,

2
√
n2 + 7− n, 2

√
n2 + 7n− n,

22n + 3n

5 · 4n + 7n
,

5 · 4n + 7n

22n + 3n
,

(
1 +

1

n

)n
,

(
2 +

1

n

)n
,

(
0.5 +

1

n

)n
,

(
1 +

1

n

)n2

,

(
1 +

1

n

)√n
,

sin(n), cos
(
n2
)
, cos (2n) .

Remark: You should be able to solve this exercise even using only paper and pencil for the following cases: 1-4, 7-12. The
Hungarian course covers 5-6, too. The last three are not at all trivial, the last one is in fact way beyond my background in
mathematics.
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2 Recursive sequences, discrete dynamical systems

Let us suppose that given the current state sn of a system at time n, we can compute what will be the sn+1 state of the
system a unit time later:

sn+1 = f(sn), (1)

where f is the function generating the time evolution of the system. Then, starting with an initial s0 state, we can generate
the sequence sn:

s0, s1 = f(s0), s2 = f(s1) = f(f(s0)) = f2(s0), s3 = f(s2) = f(f(f(s0))) = f3(s0), . . .

s0 → s1 → s2 → s3 → . . .

Here the state sn might consist of several numbers.
sn+1 might depend on several previous states, however these more complicated cases can be reduced to (1). For example

sn+1 = f(sn−1, sn) ⇐⇒ s̃n+1 =

(
sn+1

sn

)
= f̃(s̃n) =

(
f(sn−1, sn)

sn

)
.

2.1 Recognizing exponential (geometric) behaviour

The behaviour of a dynamical system around a fixed point is often described (at least approximately as long as the system
is close to the fixed point) by geometric sequences:

xn+1 = f(xn), xfix = f(xfix), ∆xn = xn − xfix,
∆xn+1 ≈ λ∆xn ⇐⇒ ∆xn ≈ λn∆x0, where λ = f ′(xfix).

The multidimensional variant is −−→
∆xn ≈

∑
i

ciλ
n
i
−→vn,

Here the summation index i runs from one to the dimension of the system. The computations of ci, λi,
−→vn are standard

exercises in linear algebra. Let us remark that this formalism can describe oscillating behaviour if one is willing to use
complex numbers like

√
−1.

How can we recognize that the sequence an = cqn is geometric from its plot?
Solution: plot n versus lg(an) = lg(cqn) = lg(c) + lg(q) · n ! Then the graph will be a straight line with slope lg(q)!
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2.1.1 Sample exercise

A bank account pays 20% interest and charges 20HUF yearly fee. What will be the balance after n years if the initial deposit
is 222HUF ?

The mathematical formulation of the problem: Let

xn+1 = 1.2xn − 20, x0 = 222 ⇐⇒ xn = 1.2n(222− 100) + 100, where xfix = 100.

Plot n↔ (xn − 100) and also n↔ (lg(xn − 100)) !
Now suppose that the xfix = 100 is unknown to us, so we plot n↔ xn and n↔ (lg(xn)). How can we use this last plot to
recover at least approximately the numbers 1.2 and 122=222-100 ?

Solution:

LibreOffice:

A2 : enter 0,

A3 : enter =A2+1,

select A3:A22,

Sheet -> Fill Cells -> Fill Down

B2 : enter 222,

B3 : enter 1.2*B2-20,

select B3:B22,

Sheet -> Fill Cells -> Fill Down,

C2 : enter =log10(B2),

select C2:C22,

Sheet -> Fill Cells -> Fill Down,

... repeat these for columns D and E .....

select A2:B22,

Insert -> Chart ... Choose Chart Type: XY (Scatter), Lines only ... Finish

... Insert a similar chart for the data of columns A and C

G1 : enter =linest(c2:c22;a2:a22;true;true) with "Return"

this will give the 0.067733 slope of the best fitting line to the n<->lg(xn) graph

G3 : enter =linest(c2:c22;a2:a22;true;true) with "Ctrl+Shift+Return"

now we get a more detailed data set:

0.0677338911947 2.28370712755946

0.001017424410523 0.011894151178379

0.995731374569587 0.02823238162055

4432.08157408962 19

3.53266761260906 0.015144280067399

Most of these numbers are coming from statistical analysis, not all of them are relevant for us. The best fitting line for the
(n, lg(xn)) data points is

lg(xn) ≈ 2.28370712755946 + 0.0677338911947 · n,
so the best approximation of the xn sequence with a geometric one is

xn ≈ 102.28370712755946 ·
(
100.0677338911947

)n
= 192.18 · 1.16878n.

This is a poor approximation of 122 · 1.2n, not too surprising since xn = 122 · 1.2n + 100. For smaller values of n the extra
100 does matters, however when n is larger, for example when n > 13, we get a more accurate picture of the asymptotic
geometric behaviour of xn. Executing ”linest(c16:c22;a16:a22;true;true)” will give

xn ≈ 142.154 · 1.19196n.

All these illustrates that even if the asymptotic behaviour is described by a geometric sequence, there might be a transitional
interval where the geometric sequence approximation does not work very well.

The results (and much more irrelevant staff) can be obtained by using Data → Statistics → Regression. By editing a
chart, one can insert a ”Trend line” for a set of data points.

We must address the question that what the meaning of xn ≈ geom.seq(n) = 122 ·1.2n might be. Two reasonable choices
are:

� xn − geom.seq(n) → 0, which is false in our case,

� xn/geom.seq(n) → 1, that is true.

Other commonly used notations expressing that xn behaves similarly to a geometric sequence with quotient 1.2 are:

� xn = O(1.2n): there exists c, n0 > 0 constants such that n > n0 implies |xn| < c · 1.2n,

� xn = Θ(1.2n): there exists c1, c2, n0 > 0 constants such that n > n0 implies c1 · 1.2n < |xn| < c2 · 1.2n
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2.1.2 Exercise

Repeat the previous exercise for the sequence

xn+1 = 0.9xn + 10, x0 = 222.

� Plot n↔ xn.

� Should we plot n↔ lg(xn) ?

� Find the xfix fixed point of this recursive law! Can you do it by using ”Tools→ Solver” ?

� Plot n↔ (xn − xfix) and n↔ lg(xn − xfix) !

� Find the best linear fit to the second graph! Figure out what would be the best geometric approximation

(xn − xfix) ≈ geom.seq(n) = abn.

Actually we have equality here.
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2.2 Nonlinear systems: logistic map

Problem: Study the behaviour of the logistic dynamical system.

xn+1 = f(x) = rxn(1− xn), x0 ∈ [0, 1], r ∈ [0, 4].

2.2.1 Exercise

Perform graphical iteration on the following figures and compare the result with the plots of xn. (Generate the plots either
by a spreadsheet program or by a computer algebra system.)

x

f(x)

f(x) = 2.5x(1− x)

x0 = 0.1

x

f(x)

f(x) = 3.5x(1− x)

x0 = 0.1

7
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2.3 Fibonacci sequence

The Fibonacci sequence is a linear recursive sequence

Fn+1 = Fn + Fn−1, F0 = 1, F1 = 1.

Linear (even multicomponent) dynamical systems can be solved explicitly using linear algebra tools. That should be compared
to the complicated behaviour of the logistic map, which is a very simple nonlinear system.
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2.3.1 Exercise

Generate the first few members of the Fibonacci sequence two ways.

� Regard it as a scalar one component system, where the next value depends on the previous two states.

� Regard it as a two component system, where the next value depends only on the previous state (which consists of two
numbers).

What would be the best fitting geometric sequence approximation of the Fibonacci sequence?

2.3.2 Exercise

Repeat the previous exercise for the sequences where the recursive law of the Fibonacci sequence is modified as

� Fn+1 = Fn + 2Fn−1,

� Fn+1 = Fn + 6Fn−1.

Find an explicit expression for Fn!
Remark: These kind of recurrence relations are explicitly solvable.

� SAGE

from sympy import Function,rsolve

from sympy.abc import n

u = Function(’u’)

f = u(n-1)+2*u(n-2)-u(n)

rsolve(f, u(n), {u(0):1,u(1):1})

... RETURNS ....

(-1)**n/3 + 2*2**n/3

Unfortunately it is very hard to figure this out of the documentation of the program package, I just copied this from
the internet.

� In Mathematica

RSolve[{f[n + 1] == f[n] + 2 f[n - 1], f[0] == 1, f[1] == 1}, f[n], n]

provides the same result
1

3

(
(−1)n + 2n+1

)
.

� In WolframAlpha this works:

f[n+1]=f[n]+2f[n-1], f[0]=1,f[1]=1
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2.4 Cobweb model of price fluctuation

See Cobweb model and Mike Rosser: Basic Mathematics For Economists, Chapter 13.

2.4.1 Exercise

Repeat the analysis of the previous page for s(p) = p, d(p) = 2/
√
p. We need inverse functions and lines for that, see the

next three pages.
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2.4.2 Exercise

Perform graphical iteration for the following supply and demand functions starting at p0 = 0.4. Compare your result with
computer generated sequences! How should you handle the following problems: a) d−1(q) does not exist, b) the value of s(p)
might be outside of the range Rd = Dd−1 .

Introduce a new coordinate system ∆p↔ ∆q whose origin is at the intersection of the demand and supply functions, i.e.
find the fixed point (equilibrium price) of the system. What will be then ∆d(∆p) and ∆s(∆p) when we are close to the fixed
point? What will be ∆d−1(∆s(∆p))? Can you determine the stability of the fixed point?

p
0

q(p)

1

1

d(p) s(p)

p0 = 0.4

1.1

0.5

p
0

q(p)

1

1

d(p)

s(p)

p0 = 0.4

0.9

0.5
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2.4.3 Exercise

One of unrealistic features of the cobweb model is that the supply next year depends only on a single number, the price this
year. What would happen if the sn+1 supply next year was s(paverage) = s((pn + pn−1)/2) instead of just s(pn)? Can this
change the stability of the equilibrium price?

Study this question for the previous exercise! What would happen if you were using a weighted average like pw.av =
0.8pn + 0.2pn−1 instead of (pn + pn−1)/2? What would happen if you were using the average price for the last three years?

2.4.4 Exercise

Our cobweb model seems to be a fairly well known toy model in mathematical economy. Try to find a few scholarly papers
discussing the questions of the previous exercise! (I have not tried this.)
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2.4.5 Exercise

Perform graphical iteration on the following figures! The were generated using the following demand and supply functions:

d(p) =

{
1

p+0.5 − 0.5 if p ∈ [0, 1.5],

0 otherwise,
s(p) = c tanh(3p), where c is either 0.7 (green) or 1.4 (red).

Explain the meaning of the marked intersection points with regard to price dynamics! What can be said about their satbility?

Figure 2: Plots of the q(p) quantity(price) functions, where q(p) is either the demand d(p) or the two supply s(p) functions.

Figure 3: Plots of the price-next-year(price-this-year)) f(p) = d−1(s(p)) functions for the two different supply functions. The
figure also contains a black auxiliary 45◦ line.

Figure 4: Plots of the price-two-years-later(price-this-year)) f2(p) = f(f(p)) functions for the two different supply functions.
The figure also contains a black auxiliary 45◦ line.
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2.5 Solving equations. Newton-Raphson method

See Newton-Raphson.
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2.5.1 Sample exercise

Compute 2
√

2 by applying the method of Newton and Raphson!

� Approximate the function f(x) = x2 − 2 by its tangent line at the initial guess x0 = 2 for the root of the equation
x2 − 2 = 0. Then find the intersection of the tangent line with the x axis, and use it as your next x1 guess for the
root. Iterate this process until the error of the difference between the two sides of the equation x2−2 = 0 is sufficiently
small.

� The Newton-Raphson method requires the knowledge of the slope of f(x). Let us suppose that we are not smart
enough to get that right, so we erroneously believe that the slope of x2 − 2 is f ′(x) = 2x 6= 3x. The incorrect guess
f ′(x) = 3x is still not completely unreasonable, it has a correct sign and is off the mark only by 50%. Use this not
quite correct slope function, then study the error of the method. Is it seems to be true, that the error decays like a
convergent (to zero) geometric sequence?

2.5.2 Exercise

� Repeat the previous exercise for 3
√

2 ! The slope function (i.e. the f ′ derivative of f) of f(x) = x3 − 2 is f ′(x) = 3x2.

� Use the two point Newton-Raphson method for the computation of 3
√

2 with initial guesses x0 = 3, x1 = 2.
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2.6 Continuous versus discrete dynamical systems. Differential equations
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2.6.1 Sample exercise

Compute approximately y(1) with Euler’s method for the following:

Diff.eq.: y′(x) = y(x), y(0) = 1,

Euler method: N = 20, ∆x = (1− 0)/20 = 0.05, x0 = 0, xn+1 = xn + ∆x, yn+1 = yn + yn ·∆x.

Then y(1) = y(20 ·∆x) ≈ y20. What is the error

error(∆x) = |y20 − exp(1)|

The exact solution of the DE is y(x) = exp(x) = ex.

2.6.2 Exercise

Repeat the previous exercise for N = 1, 2, 4, 8 and plot the obtained yn sequences together with the function exp(x).
Remark: Your solution should look like this:

The black point at the end of the exact solution is at (1, e) = (1, 2.7182818284590452354 . . . ).

2.6.3 Exercise (recognizing power like behaviour, error of the Euler method)

Make a table of the values(
n, k = 2n, 1/k, (1 + 1/k)k, |(1 + 1/k)k − e|, lg(1/k), lg |(1 + 1/k)k − e|

)
for n = 0 . . . 20.

Plot the points ( lg(1/k), lg |(1 + 1/k)k − e| ) ! Find the slope of the best fitting straight line (maybe only for the last
few of the points) ! How does the error of Euler’s method behaves in this case as a function of ∆x = 1/k ?

Remark: Assume that the error

error(∆x) = |(1 + ∆x)1/∆x − e| = |(1 + 1/k)k − e|

can be well approximated by error(∆x) ≈ c∆xα, at least when ∆x is small enough. How can we read off α from our data
set?

If err(∆x) = c∆xα, then lg(err(∆x)) = lg(c∆xα) = lg(c) + α lg(∆x), so the plot of lg(∆x) ↔ lg(err(∆x)) is a straight
line. So from the last two columns of the table, plot the last few rows (in the first few rows ∆x = 1/k is not very small), fit
a line on these points, then the slope of this trend line will approximate α. (The exact value is 1 in for ∆x→ 0.)
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2.6.4 Sample exercise (computer algebra systems for diff.eqs.)

Solve for y(1) and also plot y(x) for a few DE like

� y′(x) = 2− 2y(x), y(0) = 2,

� y′(x) = sin(y3(x)) + x, y(0) = 0.5.

Remarks:

� Explicit solution formulae are rarely available, however linear equations like the first one can be solved explicitly even
for multicomponent systems.

� There are highly efficient numerical methods, they can treat nonlinear equations like the second example.

Solution:

WolframAlpha:

y’(x)=2-2y(x), y(0)=2

returns and the plot of y(x) = e−2x + 1. I have not managed to force WA to get y(1) in one step.

Unfortunately it is not completely trivial to use CAS systems to solve DE, I think there is not much point to get into
this subject with no knowledge of programming these systems.
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